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Chapter 1 — About This Guide

Overview
This document has five major sections:

Chapter 2 — Pre-Installation Instructions on page 3.

Chapter 3 — Installation Instructions on page 5.

Chapter 4 — Post-Installation Instructions on page 9.

Chapter 5 — Validation Instructions on page 21.

Chapter 6 — Unconfiguring SAS Offer Optimization for Communications on page 27.

Prerequisites

Before you start with the installation, see Systems Requirements—SAS Offer Optimization for
Communications 5.21 for information about third-party software and operating system
specifications. This document is available at the following location:

http://support.sas.com/documentation/installcenter/en/ikbppofrsr/ 64688/
HTML/default/index.html.

Technical Support

Please visit the SAS Technical Support Web site, http://support.sas.con, for installation
updates.

For product documentation, please visit the SAS Technical Support Documentation Web site

http://support.sas.com/documentation/onlinedoc/securedoc/index offeropt.html.
Note to the reader:

Words in examples that are enclosed in < (less than) or > (greater than) symbols are meant to be
replaced with information from your system.

For example, <SAS installation path> should be replaced with the path where you
installed SAS. If you installed SAS in Program Files on your D drive, then replace <SAS
installation path> withD:/Program Files/SASHome.

<SAS configuration path>should be replaced with the path where your configuration is
installed. If you installed the configuration on the /opt path and used a configuration name of
Config93, then replace <SAS configuration path>with /opt/SAS/Config93.
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Chapter 2 — Pre-Installation Instructions

Setting Up the Oracle Database

The following subsections explain the procedures that you have to complete in order to set up the
Oracle database. You must set up the Oracle database before you install SAS Offer Optimization
for Communications 5.21 by using the SAS Deployment Wizard.

Prerequisites

Before you set up the Oracle database, make sure that you have completed the following
instructions:

1. Install Oracle database software (Oracle Database 11g Standard Edition or Oracle Database
11g Enterprise Edition) on the Data server.

2. Create a database instance with an appropriate listener service entry. This guide refers to the
listener service entry as “OOC.”

3. Install Oracle 11g ODAC (Oracle Data Access Components) software on the server-tier
machine.

4. Create a listener service entry named OOC on the server-tier machine, by using Oracle Net
Configuration Assistant. The listener service entry should point to the OOC database
instance that is created on the Data server.

Set Up the OOC Oracle Database

To set up the OOC Oracle database, complete these steps with the profile of an Oracle super user
or system user:

1. Log on to the OOC database instance from the data-tier or server-tier machine. To do so,
complete these steps:

a. Go to the command prompt.
b. Type sglplus <system username>/<system password>@0OO0C as sysdba

2. Atthe SQL prompt, create the OOC Oracle users and schemas by using the following set of
commands.

Note: In the following commands, replace <User Password> with the actual password string.
Also, make sure that you use the same user name or schema name as mentioned in the
commands listed below.

SPOOL <log filename>

CREATE USER REF IDENTIFIED BY <REF Password>;
GRANT CONNECT, RESOURCE TO REF;

CREATE USER DIM IDENTIFIED BY <DIM Password>;
GRANT CONNECT, RESOURCE TO DIM;

CREATE USER FACT IDENTIFIED BY <FACT Password>;
GRANT CONNECT, RESOURCE TO FACT;

CREATE USER MISC IDENTIFIED BY <MISC Password>;
GRANT CONNECT, RESOURCE TO MISC;

CREATE USER BASE IDENTIFIED BY <BASE Password>;
GRANT CONNECT, RESOURCE TO BASE;

CREATE USER DABT ADM IDENTIFIED BY <DABT ADM Password>;
GRANT CONNECT, RESOURCE TO DABT ADM;
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CREATE USER BPPAPTBL IDENTIFIED BY <BPPAPTBL Password>;
GRANT CONNECT, RESOURCE TO BPPAPTBL;

CREATE USER BPPINF IDENTIFIED BY <BPPINF Password>;
GRANT CONNECT, RESOURCE TO BPPINF;

CREATE USER BPPEXEC IDENTIFIED BY <BPPEXEC Password>;
GRANT ALL PRIVILEGES TO BPPEXEC;

SPOOL OFF

EXIT

3. Open the log file that is created after you complete step 2. Make sure that the log file does not
contain any errors.

Note: The log file is created in the physical directory from where you launch SQLPLUS.

Configure the ORACLE_HOME and the Shared Library Path Variables

When you install SAS Offer Optimization for Communications using the SAS Deployment
Wizard, SAS/ACCESS Interface to Oracle is used to create tables. In order to complete this task
successfully, you must configure the ORACLE_HOME and the shared library path variable. For
details, see "SAS/ACCESS Interface to Oracle Software" in Configuration Guide for SAS 9.3

Foundation for UNIX Environments. This guide is available at the following location:
http://support.sas.com/documentation/installcenter/en/ikfdtnunxcg/64205
/PDF/default/config.pdf.
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Chapter 3 — Installation Instructions

Overview

This section provides instructions to install SAS Offer Optimization for Communications on a
single physical server along with SAS 9.3 Enterprise Intelligence Platform.

Getting Started

Before you begin with the installation, complete these steps:

1. Refer to SAS 9.3 Intelligence Platform: Installation and Configuration Guide. This guide is
available at the following location:
http://support.sas.com/documentation/onlinedoc/intellplatform/.

2. Download your software into a SAS Software Depot that is accessible to all machines on
which you want to complete the installation.

3. Copy your plan files to a suitable location, such as <SAS plan file path>/plan.xml

Install SAS Server Software and SAS Offer Optimization for
Communications

To install SAS Offer Optimization for Communications and other relevant SAS products by using
the SAS Deployment Wizard, complete these steps:

1. Start the SAS Deployment Wizard.

Note: By default, the SAS Deployment Wizard for SAS Offer Optimization for Communications has
multiple managed servers. For a Typical installation, the SAS Deployment Wizard enforces
multiple managed servers. However, for a Custom installation, it is recommended that you do
not deselect the Multiple Managed Server check box.

2. Refer to Using Version 9.2 of the SAS Business Intelligence Platform to Assign Unique SAS
Application Servers to SAS Offer Optimization for Communications: Technical Paper, which is

available at the following location:
http://support.sas.com/documentation/onlinedoc/securedoc/index offer

opt.html. This technical paper provides installation instructions for a clean installation and
an up-sell scenario installation. Choose the correct scenario and follow appropriate
instructions according to your installation requirements.

Note: Perform step 3 when you reach the first screen of the SAS Deployment Wizard that enables you
to configure SAS Offer Optimization for Communications.

3. Enter the following details for SAS Foundation for Communications Server Configuration
Database Configuration.

Field name Description

Host name Enter the database server name. For example, the database server name can
be dbserver0l.abc.com.

Port number Review the port number on which the database services are running.

User name Displays BPPEXEC as the value for the database user. You cannot change
this value.

Password Enter the appropriate password for the above user name.

Confirm Password Enter the same password again, and then click Next.
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4. Enter the following details for SAS Foundation for Communications Server Configuration

Oracle Configuration.

Field name

Description

Oracle Service name

Enter the service name for your Oracle database. The default
service name is OOC.

Listener service connection
name

Enter the listener service connection name that is created as
mentioned in the pre-installation instructions in this guide. The
default service connection name is OQOC.

Click Next.

5. Enter the following details for the REF and DIM schemas.

Field name

Description

REF schema user name

Displays the user name of the REF schema. You cannot change
this value.

REF schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again.

DIM schema user name

Displays the user name of the DIM schema. You cannot change
this value.

DIM schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.

6. Enter the following details for the BASE and FACT schemas.

Field name

Description

BASE schema user name

Displays the user name of the BASE schema. You cannot change
this value.

BASE schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again.

FACT schema user name

Displays the user name of the FACT schema. You cannot change
this value.

FACT schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.

7. Enter the following details for the MISC schema.

Field name

Description

MISC schema user name

Displays the user name of the MISC schema. You cannot change
this value.

MISC schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.
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8. Enter the following details for the BPPAPTBL and DABT_ADM schemas.

Field name Description

BPPAPTBL schema user name | Displays the user name of the BPPAPTBL schema. You cannot
change this value.

BPPAPTBL schema password | Enter the appropriate password for the above user name.

Confirm Password Enter the same password again.

DABT_ADM schema user Displays the user name of the DABT _ADM schema. You cannot
name change this value.

DABT_ADM schema user Enter the appropriate password for the above user name.

name

Confirm Password Enter the same password again, and then click Next.

9. Enter the following details for the BPPINF schema.

Field name Description

BPPINF schema user name Displays the user name of the BPPINF schema. You cannot
change this value.

BPPINF schema password Enter the appropriate password for the above user name.

Confirm Password Enter the same password again, and then click Next.

10. In the SAS Offer Optimization for Communications Mid-Tier: JDBC ]Jar file dialog box,
specify the complete path where your JDBC jar file is located.

Note: Make sure that you select the [DBC jar file from the user Oracle installation directory, which is
$ORACLE HOME/sqgldeveloper/jdbc/lib. It is recommended that you should not
select the jar file from any other location. Otherwise, you might encounter errors when you start
working with the SAS Offer Optimization for Communications interface.

11. Click Next.
12. Click Finish to close the SAS Deployment Wizard after you complete the installation.

Note: SAS Offer Optimization for Communications is deployed on Managed Server SASServer11
according to your application server. Check whether this server is running. If it is not running,
then start it manually from the appropriate application console.
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Chapter 4 — Post-Installation Instructions

Overview
The post-installation instructions are categorized based on the following components:
1. Foundation data mart
2. Customer analytics
3. SAS Offer Optimization for Communications application
Make sure that you perform the instructions in the sequence listed above.
Note:

¢ In order to work with the SAS Offer Optimization for Communications application,
perform the instructions that are detailed for steps 1, 2, and 3.

e If you want to work with Customer Analytics, then perform the instructions that are
detailed for steps 1 and 2.

e If you want to configure the Foundation data mart only, then perform the instructions
that are detailed for step 1.

Create User in SAS Management Console

The user who executes the INSERT scripts that are mentioned in the instructions below needs
access to the libraries that are predefined in the SAS environment. In order to enable the user to
have this capability, you have to define this user in SAS Management Console.

To define the user who will execute the INSERT scripts, complete these steps:
1. Log on to SAS Management Console with the default profile of sasadm user.
2. Define the user with the following access permissions:

¢ Role: Metadata Server: Unrestricted

¢ Group: Communication Common Oracle User Group

3. Close SAS Management Console.

Step 1: Instructions for Foundation Data Mart

This section explains the post-installation instructions for the Foundation data mart.

Define Permissions for Data and Logs Folders

You must grant full permissions to the default user, sassrv, who will access the data that is
populated in the Foundation data mart.

Depending on the operating system of your machine, use appropriate commands to grant all
permissions to the sassrv user for the following folders:

<SAS configuration path>/Levl/Applications/SASFoundforComm5.2/Data
<SAS configuration path>/Levl/Applications/SASFoundforComm5.2/Logs
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Run the DDL Script

To update Foundation data mart tables, complete these steps:

1.

® N oo

Go to the <SAS configuration path>/Levl/<SAS Application Server context

name> folder.

Depending on whether the operating system is Windows or UNIX, run the sas.bat or the

sas. sh file respectively. For example, on the Windows machine, run the

C:/SAS/Config93/Levl/SASApp/sas.bat file.

Open the cfdn_execute ddls ml.sas macro.

On a Windows computer, this macro is located in the following folder:

<SAS installation path>/SASFoundation/9.3/comfdnsrv/sasmisc/ddl.

On a UNIX computer, this macro is located in the following folder:

<SAS installation path>/SASFoundation/9.3/misc/comfdnsrv/ddl.

Enter the appropriate values for the macro parameters.

a. Specify the appropriate value for the FILE_PATH parameter depending on whether the
operating system is Windows or UNIX. For Windows environment, enter this path as
<SAS installation path>/SASFoundation/9.3/comfdnsrv/sasmisc/ddl.
For UNIX environment, enter this path as
<SAS installation path>/SASFoundation/9.3/misc/comfdnsrv/ddl.

b. Specify the value, BPPEXEC, for the USER parameter.

c. Specify the appropriate value for the PASSWORD parameter.

d. Specify the appropriate value for the PATH parameter.

Click Save.

Click Run.

To ensure successful execution of the DDL script, select View > Log on the menu.
Close Base SAS.

Update and Run INSERT Scripts

The INSERT scripts for the Foundation data mart insert appropriate values into format and
parameter tables that are required for running ETL jobs in the Foundation data mart.

To update and run INSERT scripts, complete these steps:

1.

Go to the <SAS configuration path>/Levl/<SAS Application Server context
name> folder.

Depending on whether the operating system is Windows or UNIX, run the sas.bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C:/SAS/Config93/Levl/SASApp/sas.bat file.

Openthe all comfdn data inserts.sas macro. This macro is located in the following

folder:
<SAS configuration path>/Levl/SASApp/SASEnvironment/

SASFoundForComm5.2/SASCode/insertscripts.
Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.
b. Specity the value, MISC, for the SCHEMA parameter.
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c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the MISC schema in the procedure block and also change the
pwfile path according to your environment.
proc pwencode in='BPPEXEC' out=pwfile;

run;

e. Specify the <SAS configuration path>/Levl/SASApp/SASEnvironment/
SASFoundForComm5.2/SASCode/insertscripts value for the SCRIPTS_ROOT
parameter.

Click Save.
Click Run.

To ensure successful execution of the INSERT scripts, select View = Log on the menu.

® N o U

Openthe all comfdn data inserts ml.sas macro. This macro is located in the
<SAS configuration path>/Lev1/SASApp/SASEnvironment/

SASFoundForComm5.2/SASCode/insertscripts folder.
9. Repeat steps from 4 to 7.
10. Close Base SAS.

Import SAS Packages

To import SAS packages, complete these steps:

1. Open SAS Management Console with the default profile of sasadm user.
2. Select the Folders tab.

3. Right-click Products and select Import SAS Package.

4. In the Import from SAS Package wizard, complete these steps:

a. Click Browse and select the cfdn metadata ml. spk file. The path for this file might
differ depending on the operating system of the machine. On a Windows machine, this

file is located in the <SAS installation path>/
SASFoundation/9.3/comfdnsrv/sasmisc/Config/Deployment/Packages

folder.

b. Click OK.

c. Click Next until you reach the Summary page. The import process starts when you click
Next on this page.

Note: Before the import process begins, certain warning messages are displayed. For example, the
following warning messages are displayed:

WARN - The column "RECHARGE_ARPU" was not found in the target table
"CUST _MTH_SUMMARY _F", it will be added to the table.

WARN - The column "RECHARGE_ARPU" was not found in the target table
"CUST MTH_SUMMARY _INCR_TMP”, it will be added to the table.

WARN - The column "RECHARGE_ARPU" was not found in the target table
"CUST_PREV_MTH_ARPU_TMP", it will be added to the table.

These warnings indicate that the changes that are mentioned in the message will be applied to the
metadata. Therefore, ignore these warnings and proceed with the import process.

Page 11



SAS® Offer Optimization for Communications 5.21: Installation and Configuration Guide

6.

d. After the import process is complete, a message is displayed to indicate that the package
is imported successfully. Click View Log to see the details of the objects that are
imported.

e. Click Finish.

Repeat steps 3 and 4 to import the following packages. Make sure that you import the SAS

packages in the order that is mentioned below:

a. <SAS installation path>/
SASFoundation/9.3/comfdnsrv/sasmisc/etl/Packages/cfdn jobs ml.spk

b. <SAS installation path>/
SASFoundation/9.3/comfdnsrv/sasmisc/Config/Deployment/Packages/
cfdn cubes ml.spk

C. <SAS installation path>/
SASFoundation/9.3/comfdnsrv/sasmisc/Config/Deployment/Packages/
cfdn_infomaps ml.spk

Close SAS Management Console.

Step 2: Instructions for Customer Analytics

This section explains the post-installation instructions for the analytical components of SAS Offer
Optimization for Communications:

e Customer Retention

e Customer Segmentation

e Cross-Sell and Up-Sell

* Analytical Configuration Tables

Create User for SAS Enterprise Miner

Analytical models for customer retention, customer segmentation, and cross-sell and up-sell are
created using SAS Enterprise Miner. Therefore, you must create a dedicated external user ID,
which can be used for creating projects and developing analytical models in SAS Enterprise
Miner.

To create a user for SAS Enterprise Miner, complete these steps:

1.

2
3.
4

Open SAS Management Console with the default profile of sasadm user.
Select the Plug-ins tab.
Expand Environment Management.

Right-click User Manager and select New = User. The New User Properties dialog box
appears.

Select the General tab.

a. Enter the appropriate name and description of the user.
b. Click OK.

Select the Groups and Roles tab.

a. Select Metadata Server: Unrestricted from the Available Groups and Roles list and
move it to the Member of list.

b. Select SAS System Services from the Available Groups and Roles list and move it to the
Member of list.
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c. Click OK.
7. Select the Accounts tab.
a. Click New. The New Login Properties dialog box appears.
b. Enter appropriate User ID and Password.
c. Select DefualtAuth as the Authentication Domain.
d. Click OK.
8. Close SAS Management Console.

Configure Extension Node for Sample SAS Enterprise Miner Models

The following sample SAS Enterprise Miner models are packaged with SAS Offer Optimization
for Communications:

e Customer retention

¢ Customer segmentation

e Cross-sell and up-sell
You must configure the extension node for these models.
To configure the extension node, complete these steps:

1. Copy the following files to a suitable location on your computer. The subsequent instructions
refer to this location as <Extension node path>.

e TWriteback.sas and Writeback macros.sas

These files are available in the <SAS configuration path>/Levl/SASApp/
SASEnvironment/SASOfferOptForCommServer5.2/SASMacro folder.

e Writeback.xml

On a Windows machine, this file is available in the <SAS installation path>/
SASFoundation/9.3/bppsrv/sasmisc/sampleeminermodels/writebacknode
folder.

On a UNIX machine, this file is available in the <SAS installation path>/
SASFoundation/9.3/misc/bppsrv/sampleeminermodels folder.

e Writeback.l6.gif andWriteback.32.gif

On a Windows machine, these files are available in the <sAS installation path>/
SASFoundation/9.3/bppsrv/sasmisc/sampleeminermodels/writebacknode/images

folder.

On a UNIX machine, these files are available in the <sAs installation path>/
SASFoundation/9.3/misc/bppsrv/sampleeminermodels/writebacknode/images

folder.
2. Open Base SAS.

3. In the Explorer window, create a new library.
a. Enter a suitable name for the library.

b. Specify the path where you want to create the library.
c. Click OK.
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10.
11.
12.
13.
14.
15.
16.

17.
18.

To create a new catalog, right-click the library name and select New.

a. Inthe New Member Group window, select the Catalog icon and click OK.

b. Enter Writeback and click OK.

Double-click the Writeback catalog.

a. Right-click and select New.

b. Inthe New Entry in <Library name>.Writeback window, select Source Program.
c. Inthe Notepad window, right-click and select File > Open.

d. Select the Writeback. sas file from the <Extension node path>.

e. Close the source code editor. A file with name Untitled will appear in the Explorer
pane.

f.  Right-click this file and select Rename.

g. Enter the filename. The filename must be same as the name of the sas file that is used to
create the source program. For example, rename the file as Writeback.

h. Repeat steps from 5a to 5g for the Writeback macros.sas file.
Close Base SAS.

Copy the Writeback catalog from the location in which you created the library to a folder,
which the sashelp library can read. For example, on a Windows machine, you can copy the
catalog to the <SAS installation path>/SASFoundation/9.3/core/sashelp
folder. On a UNIX machine, you can copy the catalog to the

<SAS installation path>/SASFoundation/9.3/sashelp folder.

In the users folder, create a folder named, emext. For example, on a Windows machine,
you can create this folder in the C: /Users/<User Name> folder.

Copy the writeback.xml and the Writeback.32.gif files from the <Extension node
path> location to the emext folder.

Rename the Writeback.32.gif file to Writeback.gif.

Log on to SAS Management Console with the profile of an administrator.
In the left pane, select the Plug-ins tab.

Expand Application Management > Configuration Manager.

Expand SAS Application Infrastructure.

Right-click Enterprise Miner Mid-Tier Services 7.1 and select Properties.

On the Advanced tab, provide the path mentioned in the step 8 as the value of the
dminemid.components.extra.dir parameter.

Click OK.
Close SAS Management Console.
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Define Permissions for Data and Logs Folders

You must grant full permissions to the dedicated user that you create for performing tasks in SAS
Enterprise Miner.

Depending on the operating system of your machine, use appropriate commands to grant all
permissions to the user for the following folders:

<SAS configuration path>/Levl/Applications/SASOfferOptForCommServer5.2/Data
<SAS configuration path>/Levl/Applications/SASOfferOptForCommServer5.2/Logs

Update and Run INSERT Scripts

The INSERT scripts for the customer analytics component insert data into Analytical
Configuration Tables.

To update and run INSERT scripts, complete these steps:

1. Gotothe <SAS configuration path>/Lev1/<SAS Application Server context name>
folder.

2. Depending on whether the operating system is Windows or UNIX, run the sas.bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C:/SAS/Config93/Levl/SASApp/sas.bat file.

Note: A few error messages might be displayed when you run the sas.bat or the sas. sh file.

These errors occur because the required data sets are not available in the
<SAS configuration path>/Levl/Applications/

SASOfferOptForCommServer5.2/Data/dabt data/param folder. These data sets
are created when you perform the subsequent steps listed below. Therefore, ignore these errors
and proceed further.

3. Opentheall ca data inserts.sas macro. This macro is located in the following

folder:
<SAS configuration path>/Levl/SASApp/SASEnvironment/
SASOfferOptForCommServer5.2/SASCode/insertscripts

4. Enter appropriate values for the macro parameters.
a. Specify the value, BPPEXEC, for the USER parameter.
b. Specify the value, DABT_ADM, for the SCHEMA parameter.
c. Specify the appropriate value for the PATH parameter.

Specify the value of the DABTDATA_ROQOT parameter. You can get this value from the
<SAS configuration path>/Levl/SASApp/SASEnvironment/
SASOfferOptForCommServer5.2/SASCode/auto_declare.sas file.

&

e. Specify the password for the DABT_ADM schema in the procedure block and also
change the pwfile path according to your environment.

proc pwencode in='BPPEXEC' out=pwfile;

run;

f. Specify the <SAS configuration path>/Levl/SASApp/
SASEnvironment/SASOfferOptForCommServer5.2/SASCode/insertscripts

value for the SCRIPTS_ROOT parameter.
5. Click Save.
6. Click Run.

7. To ensure successful execution of the INSERT scripts, select View = Log on the menu.
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8. Opentheall ca data inserts ml.sas macro. This macro is located in the
<SAS configuration path>/Levl1/SASApp/SASEnvironment/

SASOfferOptForCommServer5.2/SASCode/insertscripts folder.
9. Repeat steps from 4 to 7.
10. Close Base SAS.

Include Files in Analytics Autoexec File
To include files in the autoexec file, complete these steps:
1. Open Base SAS.

2. Openthe auto declare. sas file that is located in the following folder:

<SAS configuration path>/Levl1/SASApp/
SASEnvironment/SASOfferOptForCommServer5.2/SASCode

3. Append the following statements at the bottom of the code:

%include "&autoexec root./cfdn initialize.sas";
%include "&autoexec root./autoexec cm.sas";

%include "&autoexec root./autoexec flex.sas";
4. Click Save.

Open the cfdn_autodeclare crcs.sas file thatis located in the following folder:
<SAS configuration path>/Levl/SASApp/
SASEnvironment/SASOfferOptForCommServer5.2/SASCode

6. Append the following statement at the bottom of the code:

$include "&cfdn crcs_autodeclare path./cfdn initialization crcs.sas";

7. Click Save.
8. Close Base SAS.
9. Restart the Object Spawner.

Step 3: Instructions for SAS Offer Optimization for Communications
Application

This section explains the post-installation instructions for the SAS Offer Optimization for
Communications application.

Define Permissions for Data and Logs Folders

You must grant full permissions to the default user, sassrv, who will access the data that is
populated in the Application data mart.

Depending on the operating system of your machine, use appropriate commands to grant all
permissions to the user for the following folders:

<SAS configuration path>/Levl/Applications/SASOfferOptforCommServer5.2/Data
<SAS configuration path>/Levl/Applications/SASOfferOptforCommServer5.2/Logs
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Change Library Definitions in SAS Management Console

In SAS Offer Optimization for Communications, if users run multiple projects at the same time,
then Oracle might display the error message, “ORA-08177: Cannot serialize access for this
transaction.” As a result, the project runs might fail. In order to resolve this problem, you have to
change the library definitions.

To change the library definitions, complete these steps:

X N gk ey

Log on to SAS Management Console and connect to the default profile of sasadm.

Select the Plug-ins tab.

Expand Environment Management - Data Library Manager - Libraries.

Right-click the library name, BPPAPTBL, and select Properties.

On the Options tab, click Advanced Options.

On the Locking tab, change the value for Lock type for updating to ROW.

Click OK.

Repeat steps from 4 to 7 for all the other libraries that are listed below the Libraries folder.
Close SAS Management Console.

Update and Run DDL Script

To update SAS Offer Optimization for Communications tables, complete these steps:

1.

® N o v

Go to the
<SAS configuration path>/Lev1/<SAS Application Server context name>

folder.

Depending on whether the operating system is Windows or UNIX, run the sas.bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C:/SAS/Config93/Levl/SASApp/sas.bat file.

. Open the bpp_update apdm ml.sas macro. This macro is located in the

<SAS installation path>/SASFoundation/9.3/bppsrv/sasmisc/ddl folder.
Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.

b. Specity the value, BPPAPTBL, for the SCHEMA parameter.

c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the BPPAPTBL schema in the procedure block and also change
the pwfile path according to your environment.
proc pwencode in='BPPEXEC' out=pwfile;
run,

e. Specify the <SAS installation path>/SASFoundation/9.3/bppsrv/sasmisc/ddl
value for the SCRIPTS_ROQOT parameter.

Click Save.
Click Run.
To ensure successful execution of the DDL script, select View = Log on the menu.

Close Base SAS.

Page 17



SAS® Offer Optimization for Communications 5.21: Installation and Configuration Guide

Update and Run INSERT Scripts

The INSERT scripts for the SAS Offer Optimization for Communications application component
insert prerequisite data into some of the tables of the Application data mart.

To update and run insert scripts, complete these steps:

1.

® N o @

10.

11.

12.
13.
14.

Go to the <sas configuration path>/Levl/<SAS Application Server context name>
folder.

Depending on whether the operating system is Windows or UNIX, run the sas.bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C:/SAS/Config93/Levl/SASApp/sas.bat file.

Openthe all ooc data inserts.sas macro. This macro is located in the
<SAS configuration path>/Levl/SASApp/SASEnvironment/

SASOfferOptForCommServer5.2/SASCode/insertscripts folder.

Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.

b. Specify the value, BPPAPTBL, for the SCHEMA parameter.

c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the BPPAPTBL schema in the procedure block and also change
the pwfile path according to your environment.
proc pwencode in='BPPEXEC' out=pwfile;
run;

e. Specify the <SAS configuration path>/Levl/SASApp/SASEnvironment/
SASOfferOptForCommServer5.2/SASCode/insertscripts value for the
SCRIPTS_ROOT parameter.

Click Save.

Click Run.

To ensure successful execution of the INSERT scripts, on the menu, select View - Log.

Openthe all ooc _data inserts ml.sas macro. This macro is located in the
<SAS configuration path>/Lev1/SASApp/SASEnvironment/
SASOfferOptForCommServer5.2/SASCode/insertscripts folder.

Repeat steps from 4 to 7.

Opentheall inf data inserts.sas macro. This macro is located in the following

folder:
<SAS configuration path>/Levl/SASApp/SASEnvironment/

SASOfferOptForCommServer5.2/SASCode/insertscripts.

Enter appropriate values for the macro parameters.

a.
b.

C.

Specify the value, BPPEXEC, for the USER parameter.
Specify the value, BPPINF, for the SCHEMA parameter.
Specify appropriate values for the PASSWORD and PATH parameters.

Click Save.
Click Run.

To ensure successful execution of the INSERT scripts, on the menu, select View = Log.
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15. Close Base SAS.

Import SAS Packages

1.
2.
3.

Open SAS Management Console.

Select the Folders tab.

To import the SAS package for ETL jobs, complete these steps:

a. Right-click Products and select Import SAS Package. In the Import from SAS Package
wizard, complete these steps:

b. Click Browse and select the path of the ca jobs ml. spk file. The path for this file
might differ depending on the operating system of the machine. For example, on the
Windows machine, the package is located in the <SAS installation path>/
SASFoundation/9.3/bppsrv/sasmisc/etl/Packages folder.

c. Click OK.

d. Click Next until you reach the Summary page. The import process starts when you click
Next on this page.

Note: Before the import process begins, certain warnings are displayed. For example, the
following warning messages are displayed:

WARN - The column "OFFER_TYPE_CD" was not found in the target table
"PRE_PD_USAGE_RECHARGE_B”, it will be added to the table.

WARN - The column "TOT_PYMNT_METHOD_CNT"” was not found in the target
table "PST_PD_CUST_ACCT_SNPSHT_B”, it will be added to the table.

WARN - The column "TOT_BOUNCED_PYMNT _CNT” was not found in the target
table "PST_PD_CUST_ACCT_SNPSHT_B”, it will be added to the table.

WARN - The column "TOT_BOUNCED_PYMNT _AMT” was not found in the target
table "PST_PD_CUST_ACCT_SNPSHT_B", it will be added to the table.

WARN - The column "BILL_DUE_DT" was not found in the target table
"PST_PD_PAYMENT_DRVD_B”, it will be added to the table.

These warnings indicate that the changes that are mentioned in the message will be applied to the
metadata. Therefore, ignore these warnings and proceed with the import process.

e. After the import process is complete, a message is displayed to indicate that the package
imported successfully. Click View Log to see the details of the objects that are imported.

f. Click Finish.

To import the SAS package file, coc_reports ml. spk for cross-sell and up-sell reports,

repeat steps from 3a to 3f. On a Windows machine, this file is located in the following folder:
<SAS installation path>/

SASBestPricePlanForCommunicationsMidTier/5.2/Config/Deployment/Packages.

Close SAS Management Console.
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Chapter 5 — Validation Instructions

Overview

After you have completed the post-installation instructions, make sure that you validate the
components that you have installed.

Verify the Ul Setup of SAS Offer Optimization for Communications

Make sure that you can successfully log on to SAS Offer Optimization for Communications by
using the sasadm or sasdemo user IDs.

To log on to SAS Offer Optimization for Communications, complete these steps:

1.

2
3
4.
5

In the address field of your browser specify the appropriate URL,
http://<server host name>:<server port>/SASOfferOptForComm. For example,
you can enter the URL as http://server0l.abc.com:8080/SASOfferOptForComm

In the User name box, enter the user ID as sasadm or sasdemo.
Specify the appropriate password.
Click Log On. The main application window appears.

On Application menu, click Log Off.

Verify the Metadata Layout

To verify that all the required metadata components are created successfully, complete these

steps:

1. Log on to SAS Management Console with a certain profile.

2. In the left pane, select the Folders tab.

3. Expand Products - SAS Foundation for Communications and Products > SAS Offer

Optimization for Communications.
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4. Confirm that the following subfolders are created in each of these folders.

- @ My Folder

-7 Bllineage

= [ Products

#- [ BIDashboard 4.3

- [ 543 BI Report Services

E| [:| 505 Foundation For Communications

El C| Data Sources

-7 Cubes

[ Flatfile

- [ Infomaps

-7 Libraries

- [7] Tables

Jobs

- [[7] Cust Tmp Job Group

[+ [ 7] Detived Fact Job Group

[+ ] Setup Job Group

[+ [ 545 Inteligence PlakForm

= [ 5A3 Offer Optimization For Communications
=} [ Data Sources

..H D H.H.H.H.H

- [ Flatfile
- [ Libraries
-7 Tables
- [“_‘| Jobs
- 7] mnalytics Base Job Group
[T analytics Scoring Job Group
[ analytics Setup Job Group
[:| App Reports Sourcing Job Group
[ Custamer Associations Job Group
[T Dabk Job Group
= [ 7] Reparts
- [ BPP Performance
7 Business Group Reports Maonthly
7 Business Group Reports Weekly
- [ Churn Reports Manthly
- [ Churn Reports Weekly
[ Csus Offer Reports Monkhly
(7 Csus Offer Reports Weekly
[ Csus Service Reports Manthly
[0 Csus Service Reports Weekly
[ Segmentation Reports Monkhly
7 segmentation Reports Weekly
EI [T shared Data
- [0 Swstem
- [0 Users

5. Close SAS Management Console.
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Validating the Installed Components

Verify the Software Component for SAS Offer Optimization for
Communications

To verify that the software component for SAS Offer Optimization for Communications is created
with the appropriate properties, complete the following steps:

1. Log on to SAS Management Console with the profile of an administrator.
2. In the left pane, select the Plug-ins tab.

3. Expand Application Management > Configuration Manager - SAS Application
Infrastructure.

4. Locate the Offer Opt for Comm 5.2 component.
Right-click Offer Opt for Comm 5.2 and select Properties.

6. On the Connection tab, verify the configuration details. For example, the following
configuration details can be displayed:

e Communication Protocol: HTTP

e Host Name: <host name>.apac.sas.com
e Port Number: 8080

e Service: SASOfferOptForComm

7. On the Advanced tab, make sure that the WebApp.ConfigHome property points to the
correct configuration file. For example, the WebApp.ConfigHome property can point to the

configuration file, located at: <SAS configuration path>/
Levl/Web/Applications/SASOfferOptForComm5.2/BPPConfiguration.xml

8. Close SAS Management Console.

Verify Roles and Capabilities

To verify that appropriate roles and capabilities are created, complete the following steps:
1. Log on to SAS Management Console with the profile of an administrator.

2. In the left pane, select the Plug-ins tab.

3. Expand Environment Management and select User Manager.

4

In the right pane, make sure that the following roles or groups are available:

Group Name or Role Name Group or Role
Offer Opt for Comm Analysts Group

Offer Opt for Comm: Administration Role

Offer Opt for Comm: Analysis Role

Offer Opt for Comm: Viewing Role

5. Right-click on any one of the roles and select Properties.

6. On the Capabilities tab, make sure that the capabilities of SAS Offer Optimization for
Communications are defined for this role. Also, confirm that all the role-specific capabilities
are selected.

7. Close SAS Management Console.
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Verify the Stored Processes

To verify that the stored procedures are registered appropriately, complete the following steps:

1.
2.
3.

Log on to SAS Management Console with the profile of an administrator.
In the left pane, select the Folders tab.

Expand System = Applications > SAS Offer Optimization for Communications = Offer
Opt for Comm Server 5.2.

Select select ooc_stp and in the right pane verify that 27 stored processes are registered.

Close SAS Management Console.

Verify the Database Connections

JBOSS

To confirm that the data source is valid, complete the following steps:

1. Go tothe <JBOSS HOME>/server/SASServerll/deploy folder.

2. Locate the BPPDataSource-ds.xml file.

3. Open the file and check if the connection URL tag has the correct entry. For example, the
entry can be <connection-
url>jdbc:oracle:thin:@//dbserverOl.abc.com:1521/<service
name></connection-url>

WebSphere

To confirm that the data source is valid, complete the following steps:

1. Log on to WebSphere Admin Console.

2. In the left pane, select Resources = JDBC > Data sources.

3. In the right pane, select BPPDataSource.

4. Verify the following details:
a. The JNDI name is the same as mentioned in the BPPConfiguration file.
b. Check the URL in the Oracle data source properties. For example, the URL can be

jdbc:oracle:thin:@//dbserver0l.abc.com:1521/<service name>.

5. Log off from WebSphere Admin Console.

WebLogic

To confirm that the datasource is valid, complete the following steps:

1. Log onto WebLogic Admin Console.

2. In the left pane, select Services <> JDBC -> Data sources.

3. In the right pane, select BPPDataSource.

4. Make sure that the JNDI name is the same as mentioned in the BPPConfiguration file.

5. On the Connection Pool tab, verify the URL in the Oracle data source properties. For
example, the URL can be
jdbc:oracle:thin:@//dbserver0l.abc.com:1521/<service name>.

6. Log off from WebLogic Admin Console.
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Verify the Entries in the Autoexec File

To verify that the Autoexec file has valid entries:

1. Gotothe <SAS configuration path>/SASApp folder.
2. Open the appserver autoexec.sas file.

3. Make sure that the following entries are available:

$include "<SAS configuration path>/SASApp/bppsrvc_autoexec.sas";

$include "<SAS configuration path>/SASApp/comfdnsrvc_autoexec.sas";

Verify the Predefined Libraries

To confirm that the predefined libraries are created appropriately, complete these steps:
1. Log on to SAS Management Console with the profile of an administrator.

2. In the left pane, select the Plug-ins tab.

3. Expand Environment Management - Data Library manager -> Libraries.

4

Make sure that the following libraries are created:
=[] Libraries

----- EFPAPTEL

..... EPPINF

..... CFDEASE

----- CFDMCOMF

----- CFOOIM

..... CFOFACT

..... CFDMISC

----- CFDREF

----- DABT_ADM

..... ERR_LIE

..... ERROR

..... FMT

----- DOCADD - SASDATA

----- OOCApR - wrsdist

----- O2ZApp - wrstemp

----- SHLIE

..... (5§ TP Samples

5. Close SAS Management Console.

Perform Administrative Tasks

After you complete the post-installation tasks, you have to perform certain administrative tasks.
For details, see SAS Offer Optimization for Communications: Administrator’s Guide. This document is

available at the following location:
http://support.sas.com/documentation/onlinedoc/securedoc/index offeropt.html
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Communications

Pre-Unconfiguration Tasks

You must perform the following tasks before you unconfigure SAS Offer Optimization for
Communications:

Delete OLAP Cube Metadata

To delete the OLAP cubes metadata, complete these steps:

1. Log on to SAS Data Integration Studio and connect to the sasadm profile.

2. In the left pane, select the Folders tab.

3. Expand Products > SAS Foundation for Communications - Data Sources - Cubes.
If a cube is built, right-click the cube and select Maintain - Delete Physical Cube.

4
5. Right-click the same cube and select Delete. This step deletes the cube metadata.
6. Repeat steps 4 and 5 for all the other cubes.

7

Close SAS Data Integration Studio.

Create a Backup of Metadata Customizations

To create a backup of metadata customizations that you might want to use later, complete these
steps:

1. Log on to SAS Management Console and connect to the sasadm profile.
2. In the left pane, select the Folders tab.
3. Expand Products.

4. Back up the following folders if you have made any customizations that you might want to
save for later use, and then delete the folders:

e SASFoundation for Communications
e SAS Offer Optimization for Communications

5. Close SAS Management Console.

Create a Backup of Your Configuration Data

Create a backup of the following folders if you want to maintain a copy of your previous data:
<SAS configuration path>/Applications/SASFoundforComm5. 2

<SAS configuration path>/Applications/SASOfferOptforCommServer5.2

Create a Backup of Your Application Data

Create a backup of your application data that you have maintained in the Oracle database by
using a suitable archival or backup method.
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Removing the Configuration Using SAS Deployment Manager

The Remove Existing Configuration feature of SAS Deployment Manager provides an
automated way to remove the SAS Offer Optimization for Communications configuration from
your environment. However, this feature does not remove the configuration completely. You

have to perform certain manual steps in order to remove the complete configuration.

After you run the Remove Existing Configuration feature, SAS Deployment Manager displays
the summary of components that were successfully unconfigured and also the summary of

components that need to be removed manually.

Post-Unconfiguration Tasks

After you use SAS Deployment Manager to unconfigure SAS Foundation for Communications
and SAS Offer Optimization for Communications, perform the following tasks to complete the
unconfiguration process:

1.

2
3
4.
5

.G\

10.
11.

12.

Restart the Object Spawner.

Log on to SAS Management Console and connect to the sasadm profile.
In the left pane, select the Folders tab.

Expand SAS Folders - Shared Data.

Delete <Offer Optimization-Specific Application Server>-OLAP Schema. For example, the
schema name can be OOCApp-OLAP Schema.

On the Plug-ins tab, expand Environment Management - Server Manager.

Delete <Offer Optimization-Specific Application Server>-OLAP Server. For example, the
server name can be OOCApp-OLAP Server.

On the Folders tab, expand SAS Folders - Products.

Delete all metadata in the following folders and then delete the folders also:

e SAS Offer Optimization for Communications

e SAS Foundation for Communications

Close SAS Management Console.

Delete the following physical folders:

e <SAS configuration path>/Applications/SASOfferOptforCommServer5.2
e <SAS configuration path>/Applications/SASFoundforComm5.2

If you also unconfigured the Offer Optimization-Specific Application Server when you

unconfigured SAS Offer Optimization for Communications, then delete the following folder:
<SAS configuration path>/<Offer Optimization-Specific Application Server>.

For example, the folder can be C: /SAS/Config93/Lev1/00CApPP.
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